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Chapter I. 

About Chapters 

There are two ways to add a new chapter. First, you can simply type the name of 

your new chapter on a separate line and apply the Chapter Title (or Heading 2) style. 

That will automatically drop your chapter title down to the next page and you may then 

begin your next chapter. Alternatively, you can copy this section, from the chapter title 

down to the section break, and then paste it immediately following the section break. 

Whether you need a section break is largely determined by what you plan to do 

with the structure of your thesis. If you need more than one column (say, for columns of 

statistics), for example, you’ll want a section break, then another to switch back to one 

column. 

To insert a new section break, go to the Layout tab in the Ribbon. In the Page 

Setup section, choose the Breaks dropdown menu; from the second half of the list, 

choose Section Break: Next Page or Section Break: Continuous if you don’t want a page 

break.

Commented [TN6]: You will need to type the chapter 

number manually for each chapter. Also remember that you 

need to use a soft return (Shift+Enter) between the chapter 

number and its title. 



 

 

Chapter II. 

Chapter Styles 

There are several styles that are used within chapters that you’ll need to know 

how to use. Other styles in the document are used in specific circumstances only, but 

we’ll cover those later.  

Heading 3, SectionTitle/A-Head 

The Chapter Title or “Major heading” style (shown in the Quick Styles menu as 

“Ch Title”) is used at the beginning of each chapter, including the appendices. For an 

example, see “Chapter 1 About Chapters” above. The first line of the title text will 

always begin 2” from the top of the page. The style immediately following the Chapter 

Title style will default to the Body Text style, to be used for the introduction of the 

chapter. 

Chapter titles will automatically be included in the Table of Contents, but in order 

for them to appear after they’re first added, you’ll need to right-click on the TOC and 

choose “Update entire table.” To ensure that the chapter title is formatted correctly both 

on the page and in the corresponding TOC entry, there are two commands you’ll need to 

use for each: 

• In the TOC entry for Chapter 1, you’ll notice that there’s a half-inch space 

between the words “Chapter 1:” and the chapter title. This is accomplished by 

using a Tab character in the title itself. The Chapter Title style has been designed 

Commented [TN7]: In order to get the proper spacing for a 

chapter heading, go to the Layout tab and click on the Breaks 

button, then select Next Page under Section Breaks. (Note: 

typically, Word will insert a stray paragraph return above 

your heading that will need to be deleted.) 
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so that this Tab character will not interfere with the centering of the header and 

therefore will not appear to be present on this page at all; if the TOC entry does 

not contain that half-inch space, remember to add a Tab character. 

• In the Chapter 1 example above, you’ll notice that the chapter title falls on two 

different lines, with the words “Chapter 1:” on the first line and the chapter title 

itself on the second line. If you use the Enter key to separate these (called a “hard 

return”), they will appear much farther apart on the page and will appear in the 

TOC as two separate entries. To prevent this, you’ll need to use what’s called a 

“soft-return” by pressing Shift + Enter (just after the Tab character mentioned 

previously). This command tells the computer that you want the second line to be 

considered part of the same header or paragraph even as it appears on a new line. 

Heading 4, B-Head 

The Section Title or A-Head style (shown in the Quick Styles menu as “Sect 

Title”) is used as a header for a section within a chapter. For an example, see “Chapter 

Styles” above. Note: there should always be introductory text for the chapter before the 

Section Title. The style immediately following the Section Title style will default to the 

Body Text style, to be used for the introduction of the section. 

Section titles will automatically be added to the Table of Contents, directly below 

the previous chapter title and with a half-inch indent, each time you update the whole 

TOC. 



 

4 

B-Head Style 

The B-Head style (shown in the Quick Styles menu as “B-Head”) is used as a 

header for a subsection within a section of a chapter. For an example, see “B-Head Style” 

above. Note: there should always be introductory text for the section before the B-Head. 

The style immediately following the B-Head style will default to the Body Text style, to 

be used for the introduction of the subsection. 

B-Heads will automatically be added to the Table of Contents, directly below the 

previous section title and with a one-inch indent, each time you update the whole TOC. 

B-Head Style 

The Body Text style (shown in the Quick Styles menu as “Body Text”) is used for 

standard paragraph styles. This paragraph is using the Body Text style; the default style 

for the next paragraph is also Body Text. 

C-Head Style and Accompanying Paragraph 

The C-Head style (shown in the Quick Styles menu as “C-Head”) is used as a 

header for a subsection within a subsection. For example: 

Body Text with C-Head. This is a C-Head and accompanying paragraph. Note that the C-

Head is on the same line as the rest of the paragraph; it’s not indented; and there is no 

additional space before the C-Head as there is with other headers. 

C-Heads will automatically be added to the Table of Contents, directly below the 

previous subsection title and with a 1.5-inch indent, each time you update the whole 

TOC. 
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To apply the C-Head style, select the paragraph to which it belongs and click on 

the “Body Text w/ C-Head” style in the Quick Styles menu; then select the C-Head itself 

and click on the “C-Head” style. 

Remember, there should always be introductory text for the subsection before the 

C-Head. The style immediately following the C-Head style will default to the Body Text 

style. 

Numbered List Style 

To create a numbered list, select the lines of text which you want to make a list 

(whether they’re already in a Word list structure or not) and choose the “Numbered List” 

style in the Quick Styles menu. If the list was in a Word list structure previously, it will 

simply update the styles. If the list was previously formatted by hand, you will need to 

check that list items begin and end at the correct points and that any typed numbering is 

removed. 

1. This is the Numbered list style. 

2. To add a list item, simply hit Enter at the end of the previous list item. 

3. To end the list, hit Enter and then select the “Body Text” style from the Quick 

Styles menu. 

If you wish to create a second numbered list, follow the directions for creating a 

list above, then right-click on the list and choose “Restart at 1.” If this does not work, 

right-click and choose “Set Numbering Value” and set it to create a new list starting from 

1. If either of these methods creates a list starting with 1 but with the second item in the 
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list continuing numbering from a previous list, you may need to right-click on that second 

item and again choose “Set Numbering Value,” this time choosing to start from 2. 

Bulleted List Style 

To create a bulleted list, select the lines of text which you want to make a list 

(whether they’re already in a Word list structure or not) and choose the “Bulleted List” 

style in the Quick Styles menu. If the list was in a Word list structure previously, it will 

simply update the styles. If the list was previously formatted by hand, you will need to 

check that list items begin and end at the correct points and that any typed bullets are 

removed. 

• This is the Bulleted list style. 

• To add a list item, simply hit Enter at the end of the previous list item. 

• To end the list, hit Enter and then select the “Body Text” style from the Quick 

Styles menu. 

This is what some body text after a bulleted list would look like. 

Block Quote Style 

The Block Quote Style is used for quoting large selections of text, rather than a 

word or phrase. 

Blockquotes are further indented to distinguish them from body text. 

They’re also single-spaced rather than double-spaced. 

A multi-paragraph block quote will look like this, with a space between 

the paragraphs to differentiate them. 
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Figures 

To insert a figure, place your cursor at the beginning of the Figure Title line. You 

can either copy and paste a figure into the document or use the Insert Pictures command 

in the Insert ribbon. Once you have the image inserted, click on the picture and select the 

dropdown menu that appears: make sure the “In Line With Text” option is selected, in 

order to keep the picture aligned properly and associated with the correct text. Example 

(the gray box is merely a placeholder to show you how it should look): 

Figure 1. Figure Title. 

Description of Figure 1, legend brief citation, etc. 

Figure Title Style. The Figure Title style, which appears in the Quick Styles menu as 

“Figure Title,” is used to name a figure in a way that will appear in the TOC. The title 

will automatically be added to the List of Figures following an update of the entire table. 

Remember to place a tab between the figure number and the title, as shown above, in 

order to preserve formatting in the TOC. Note: the style of the paragraph following 

Figure Title defaults to Figure Description. 

Figure Description Style. The Figure Description style, which appears in the Quick Styles 

menu as “Figure Description,” is used to briefly describe the accompanying figure; the 

space after it separates it from the body text below the figure. 
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Tables 

Tables can copied and pasted from another document or created in the Word 

document itself using the Insert Table command on the Insert tab of the ribbon. A sample 

table: 

Table 1. Table Title. 

Lorem ipsum Augue vel tellus Sed sagittis 

Est blandit 0 1 

Sed est 0 1 

Table description style, legend, brief citation etc. 

Following insertion using either method, table styles should be applied as follows. 

Table Title Style. The Table Title should come immediately before the table itself; the 

style appears in the Quick Styles menu as “Table Title,” In order to preserve formatting 

of the TOC entry, insert a Tab character between the table number and the table title, as 

shown above. 

Table Cell Style. To apply this style to the table cells, highlight the table and choose 

“Table Cell” from the Quick Styles menu. The default will be to left-align the text inside 

the cells; to center text, as in the second and third columns above, you can simply select 

those cells and choose Center. To control vertical alignment as necessary, select the 

applicable cells and choose the Layout tab that appears in the ribbon. On the right in the 
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Alignment section, choose the graphic that matches the alignment you prefer, from top 

left to bottom right to centered horizontally and vertically. 

Table Description Style. The Table Description style, shown in the Quick Styles menu as 

“Table Description,” is used to format the brief description of the table immediately 

following said table. This style also includes space after to differentiate it from later 

paragraphs. 

Styles Used in Other Parts of the Document 

Title Style 

The only time the Title style is used is on the first page of the document. It is 

exactly 2” from the top of the document. 

Author Style 

The Author style is also used only on the first page of the document and begins 

exactly 2” below the title. 

Centered Text Style 

The Centered Text style is to be used on the first page for the Degree information. 

Harvard,Month,Year Style 

The Harvard,Month,Year style is for use on the front page for the University 

name and the month and year of graduation. 
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Copyright Style 

The Copyright style is for use on the second page for copyright information. 

No-TOC-Heading Style 

The No-TOC-Heading style is for use when chapter-type headings should not be 

included in the table of contents, such as the Abstract. Its appearance is exactly the same 

as the Chapter Title style but will not be included when the table of contents is updated. 

Bibliography Entry Style 

The Bibliography Entry style is single-spaced with a double-space between 

entries and has a hanging indent of one-half inch. The sample text includes only a few 

examples of different style guides for different types of document: please be sure to 

format your bibliography entries using the style guide required for your thesis type. 
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Appendix 1. 

Title 

The following tables can be copied and pasted into other sections of this 

document, then changed to the appropriate size and filled with content. 

To add a row, hover your mouse to the left of one of the gray lines between or 

after rows; to add a column, hover your mouse above one of the gray lines between or 

after columns. In either case, a thicker line will appear with a “+” sign at the top; click 

this to add a row or column. Note that when doing so, the width of columns and height of 

rows will distribute evenly. 

To delete cells, highlight them and right-click, choosing the Delete Cells option. 

This will give you two types of options: you can delete only the highlighted cells and 

choose whether to move the remaining cells up or left; or you can delete the entire row or 

column that the highlighted cells belong to. 

Table 2. Table Title 

Lorem ipsum Augue vel tellus Sed sagittis 

Est blandit 0 1 

Sed est 0 1 

Table description style 
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Appendix 2. 

Title 

The following is placeholder text to show you how an appendix might fill out 

with an image, figure title and description. Delete and replace with your own as 

necessary. 

Figure 2. Figure Title 

Sample text for Figure 2 description 

We hope that this thesis template helps you to concentrate on the substance of 

your writing as opposed to spending time on formatting details, and that your thesis work 

goes as well as possible for you!
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